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Techniques for digital restoration of cranial elements 
on three-dimensional surface models

Florencia S. Filippini, Fernando Abdala, and Guillermo H. Cassini

ABSTRACT

Digital restoration is the process by which preservational or other types of damage
are removed to recover the putative original morphology of fossil specimens. In the
present work, three-dimensional (3D) surface models of skulls and mandibles of 32
cynognathians (Synapsida, Cynodontia) specimens from South America were digitally
restored. The main restoration techniques used come from the literature and are
adapted to the particular preservational problem. A classification into three restoration
grades (low, medium and high) is proposed, taking into account the number of tech-
niques used and the percentage of damage of the fossil. The higher the degree of
damage, the greater the complexity of the restoration and the higher the level of inter-
pretation added. Of all the specimens, 36.5% presented a low grade of restoration,
15% presented a medium grade, and 7.3% a high grade. Among the major damages
recorded in the cynognathians specimens the following stand out: partial or total frag-
mentation of one of the zygomatic arches, total loss of the postdentary bones, frag-
mentation of the coronoid processes, and lithostatic deformation. The unidirectional
deformation could not be completely eliminated in the fossils that presented it, being
the only unresolved restorative problem. Detailing and documenting the totality of the
restorative procedures allows establishing a traceability of the changes applied to the
specimens, being extremely useful for researchers confronted with similar problems.
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INTRODUCTION

Digitization of fossil material has advanced
significantly over the past few decades and has
proven to be very useful in enabling new
approaches in the studies of extinct organisms
(Cunningham et al., 2014), as well as generating
digital specimens accessible to researchers as
they conform digital collections (Digital Atlas of
Ancient Life, Morphosource, MorphoMuseuM,
Sketchfab). The preservation of fossil material of
vertebrates remains a problematic issue as the
specimens are often disarticulated, fractured,
incomplete, and/or deformed (Shipman, 1981;
Lyman, 1994). Many studies require the analysis of
specimens in which morphological distortions were
previously corrected (Mallison, 2010; Molnar et al.,
2012; Tschopp et al., 2013; Cuff and Rayfield,
2015). With the enormous progress in digital tech-
niques, emphasis has been placed in recent years
on the restoration of fossil material. This area has
not been extensively explored in vertebrate paleon-
tology as it has been in archeology and paleoan-
thropology, where restoration and reconstruction,
especially of hominid crania, is a widespread prac-
tice (Davis and Napier, 1963; Walker et al., 1983;
Ponce de León and Zollikofer, 1999; Zollikofer and
Ponce de León, 2005; Gunz et al., 2009; Schlager
et al., 2018).

Digital restoration involves the process of
removing preservational and other artifacts to
restore the morphology of a fossil specimen as
close as possible to its assumed natural condition
prior to fossilization, employing a combination of
different software packages and techniques (Laut-
enschlager, 2016a). Although digital modeling
offers multiple tools to perform this task, it is fre-
quently the case in which the protocols and criteria
used to restore fossils specimens are not
described in detailed for other researchers to follow
the same protocol, being Lautenschlager (2016b)
one of the few guiding works for a first approach to
the subject. It is important to note that the majority

of publications usually describes the restoration of
a single specimen or of several elements of differ-
ent unrelated specimens (Díez Díaz et al., 2020;
Demuth et al., 2022; DeVries et al., 2022; Ruella et
al., 2024). Restoration of a large sample of fossil
material from the same taxon is not commonly doc-
umented. Principally, due to the fact that a large
sample of collected specimens is needed and is
not common for fossil vertebrates, an exceptional
case would be the cynognathians.

Cynognathians are a group of non-mamma-
lian cynodonts that are well represented particu-
larly in southern Pangaea and are the most
abundant component in the Triassic faunas of
Argentina (Abdala et al., 2020). Thus, many spe-
cies of the group are represented by several speci-
mens. However, like usually happens with most
fossils, diagenesis and taphonomic processes
affect their preservation. Cynognathians are char-
acterized by broad skulls with a triangular appear-
ance in dorsal view due to the contrast between
the snout and the wide temporal fossae that pro-
duce a much broader posterior portion of the skull.
They have broad zygomatic arches, a generally
robust snout, and a jaw composed of a large den-
tary and more delicate postdentary elements form-
ing a postdentary bar that loosely articulate with
the dentary (Kielan-Jaworowska et al., 2004,
Kemp, 2005; Abdala et al., 2020; Rougier et al.,
2021).

In this contribution, we describe modified res-
toration techniques from Lautenschlager (2016b)
to apply specifically to 3D surface models. We
record the damage and deformations present in
combination with the restoration techniques used
for each cranial element in our fossil sample. In
addition, a classification based on the level of res-
toration is proposed that qualitatively considers the
degree of uncertainty added and the amount of
work performed. In this way, a more complete
record of the restoration process is reported and
thus is more clearly defined for future use.
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MATERIALS AND METHODS

Institutional Abbreviations 

MACN-PV, Colección de Paleovertebrados, Museo
Argentino de Ciencias Naturales “Bernardino
Rivadavia”, Buenos Aires, Argentina; MLP, Museo
de La Plata, La Plata, Argentina; PULR, Universi-
dad Nacional de La Rioja, Argentina; PVL, Colec-
ción de Paleontología de Vertebrados, Instituto
Miguel Lillo, Universidad Nacional de Tucumán,
Argentina. 

Specimens

The digitally restored material corresponds to
a series of skulls and mandibles of 32 specimens
of Cynognathia from Argentina, housed in MACN,
MLP, PULR, and PVL paleontological collections.
The species included are:
Cynognathus crateronotus Seeley, 1895. Horizon:

Rio Seco de la Quebrada Formation (Puesto
Viejo Group); age: ?lower Carnian (Upper Tri-
assic). Represented by PVL 3859.

Pascualgnathus polanskii Bonaparte, 1966; hori-
zon: Rio Seco de la Quebrada Formation
(Puesto Viejo Group); age: ?lower Carnian
(Upper Triassic). Represented by tree speci-
mens: PVL 3466, PVL 4416 and MLP 65-VI-
18-1.

Andescynodon mendozensis Bonaparte, 1969;
horizon: Cerro de las Cabras Formation: age:
upper Anisian (Middle Triassic). Represented
by 11 specimens: PVL 4390, PVL 3092, PVL
3899, PVL 3900, PVL 3833, PVL 3834, PVL
3840, PVL 3835, PVL 3891, PVL 3898, PVL
4072, PVL 3890 and PVL 3894.

Massetognathus pascuali Romer, 1967; horizon:
Chañares Formation; age: upper Ladinian-
lower Carnian (Upper Triassic). Represented
by 13 specimens. PULR v02, PVL 3901, PVL
3902, PVL 3904, PULR v10, PULR v13, PVL
3903, PVL 4728, PULR v11, PVL 4727, PVL
4729, PVL 5441, PVL 4726 and PVL 4613. 

Exaeretodon argentinus Cabrera, 1943; horizon:
Ischigualasto Formation; age: upper Carnian
(Upper Triassic). Represented by five speci-
mens: MACN-PV 18125, PVL 2564, PVL
2473, PVL 2056, PVL 2066, PVL 2467, PVL
2554 and PVL 2565.

Restoration

To proceed with the restoration, the workflow
proposed by Lautenschlager (2016) for the digital
restoration of surface models was used as base-
line. Likewise, the techniques proposed in that

work were adapted to be performed on surface
models since they are mostly explained and
applied to CT scanned models. The restoration
process was performed by the same person to
ensure consistency.
Digitization. Fossils were initially digitalized to
obtain three-dimensional (3D) morphology as origi-
nally preserved. Photogrammetry was utilized to
create surface-based 3D models. A DSLR (Digital
Single Lens Reflex) camera with a fixed focal
range of 55 mm was used to capture between 300
and 400 photos per cranial element, with a resolu-
tion of 24 Mpx (6000 x 4000 pixels) per photo. To
achieve maximum coverage and to maintain nec-
essary overlap, multiple photo cycles were taken at
different planes, with photos taken every 7° (48
photos per cycle). The photographs were then pro-
cessed using Agisoft® Metashape v.1.6.5 software
to obtain the 3D models in PLY format.
Software. Various programs were used to achieve
the restorations on the 3D surface models,
depending on the techniques employed. Agisoft®
Metashape v.1.6.5 was used to visualize, edit, and
isolate elements of the 3D models. Most of the res-
toration techniques were carried out in Blender v.
2.93 (www.blender.org); retrodeformation was car-
ried out using Landmark v.3.0.0.6 (Institute for Data
Analysis and Visualization, University of California;
Wiley et al., 2005). Finally, the restored models
were obtained using MeshLab (https://www.mesh-
lab.net/; Cignoni et al., 2008).
Restoration techniques. The following sections
describe the techniques applied, detailing the nec-
essary steps for restoration using Blender and
Landmark programs on 3D models obtained by
photogrammetry in Metashape.
Reflection of elements: This method is commonly
used when the fossil is incomplete due to fragmen-
tation. It exploits the bilateral symmetry of verte-
brates to complete the missing element by
mirroring its counterpart, as long as the other half
of the fossil is well-preserved.
Superimposition: Fossils often exhibit varying
degrees of fragmentation, even within the same
specimen. In some cases, neither side of the spec-
imen is complete, nor are larger areas of the fossil
compromised. Therefore, the problem cannot be
resolved by simply mirroring one side, or if the
affected area has no bilaterally symmetrical coun-
terpart (e.g., sagittal crest). To restore incomplete
areas, the counterparts of the elements must be
superimposed with each other, especially when
each side of the fossil has a different state of pres-
ervation. In the case of non-symmetrical elements,
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the area can be restored by superimposing the ele-
ment from other specimens of similar size. 
Retrodeformation: Plastic deformation alters the
original form of the fossil, modifying its morphology
while preserving its elements. Retrodeformation is
the process of restoring the original shape by
applying the same amount of deformation but in
the opposite direction. Most three-dimensional ret-
rodeformation methods use the principle of bilat-
eral symmetry, assuming that a symmetric
counterpart has undergone shear or deformation
with respect to the other part.
Restoration grades. A simple classification is pro-
posed to better categorize the fossil sample. This is
necessary due to the varying degrees of damage
and deformation that can be observed, which
resulted in different levels of complexity in the res-
toration process. As a result, there is a certain level
of uncertainty. The number and extension of struc-
tures to be restored from a specimen varies based
on its preservation and deformation, and could be
expressed as a percentage. Therefore, based on
the number of techniques used and the original
condition of the specimen, we establish three lev-
els of restoration:
Low restoration level: A restoration defined as sim-
ple, where the material is complete but deformed
or only slightly damaged, with less than 15% of the
fossil missing. It is therefore necessary to use only
one restoration technique.
Medium restoration level: A moderately complex
restoration that is solved by applying at least two
techniques, for example, the specimen is deformed
and broken; or only one technique is applied, but
large sections of the fossil (20 - 50%) are missing.
High restoration level: Refers to a complex resto-
ration process that involves multiple techniques to
address the problem. It includes specimens that
have a high degree of deformation and a signifi-
cant amount of damage or missing elements (over
50%).

RESULTS

Damage and Deformation Observed

Table 1 lists the specimens detailing the dam-
age recorded, the restoration techniques used, the
percentage restored, and the level of restoration
according to the proposed classification. Regard-
ing the degree of damage, in the entire sample, the
zygomatic arches of the skull and the coronoid pro-
cesses of the dentary are usually partially pre-
served throughout the sample. A delicate skeletal
part, which tends to be completely missing, are the

postdentary bones. These elements are loosely
articulated to the dentary and in most cases are not
preserved even when the skull and mandible (den-
tary plus splenial) are articulated. Within each spe-
cies, different degrees of damage or deformation
are found. The Cynognathus skull and mandible
are complete with a very slight degree of deforma-
tion which allowed a rapid restoration. The skulls of
Andescynodon are, in general, poorly preserved,
presenting often crushing, and, less frequently
compression. In several specimens of this taxon,
large parts of the zygomatic arch and the postor-
bital bar are missing, whereas, the coronoid pro-
cesses of the mandible are usually incomplete,
even when both hemimandibles are preserved. As
for Pascualgnathus it presents two particular
cases, on the one hand the specimen
MLP 65-VI-18-1 it seems has the zygomatic arch
removed by preparation action. On the other hand,
the PVL 4416 specimen presents the highest
degree of deformation of the sample. Massetog-
nathus shows a high level of preservation, with low
deformation and some fragmentation of parts of the
zygomatic arch or the tips of the coronoid pro-
cesses of the mandible.

Exaeretodon specimens are by far the largest
fossils in the sample, and in the skulls the main
damage is observed in the zygomatic arches (in
which one of them is usually incomplete). In addi-
tion, presents parietal and occipital ridges with dif-
ferent degrees of damage, partially or completely
missing. Mandibles often have missing parts of the
coronoid processes, and some specimens show a
high degree of compression (dorsoventrally or
mediolaterally).

Adaptation of Techniques to Surfaces 3D 
Models

Reflection of elements. Many specimens in our
sample have only one complete zygomatic arch in
the cranium (e.g., Massetognathus specimens PVL
3901, PVL 4613 PULR v02, Exaeretodon PVL
2056, Andescynodon PVL 3890, and Pascual-
gnathus MLP 65-VI-18-1, Table 1) or have missing
fragments of the coronoid processes of the mandi-
ble (e.g., Massetognathus PVL 3903 and PVL
4613, Exaeretodon PVL 2564, Table 1). In these
cases, incomplete elements can be repaired by
mirroring the bilaterally symmetrical counterpart
from the same specimen (Figure 1). 

To perform these techniques, the element to
be mirrored must first be isolated using
Metashape, selecting and isolating the area of
interest by editing the dense point cloud. Once the
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TABLE 1. Lists of the cynognathian specimens detailing the damage recorded, the restoration techniques used, the
percentage restored and the level of restoration according to the proposed classification.

Specimen Cranial element Recorded damage

Restoration technique
% 

rest.
Rest. 
level

Ref. 
&Sup. Retrd. Extrp.

Andescynodon mendozensis

PVL 3092 articulated skull and 
mandible 

Right zygomatic arch absent 
and both coronoid processes 
incomplete 

X X 45% medium

PVL 3833 skull Right orbit and zygomatic arch 
absent

X 40% medium

PVL 3834 skull Both zygomatic arches are 
incomplete. 

X 10% low

PVL 3835 mandible Both coronoid processes 
incomplete

X X 35% medium

PVL 3890 skull Right zygomatic arch and orbit 
absent, anterior part of the 
snout incomplete

X 40% medium

PVL 3891 mandible both coronoid processes 
incomplete

X 30% medium

PVL 3894 skull Right zygomatic arch absent, 
left maxilla and orbit 
incomplete, shear deformed.

X X 50% medium/ 
high

PVL 3894 mandible Both coronoid processes are 
incomplete. Shear deformed.

X 30 % medium

PVL 3898 mandibles Both coronoid processes 
incomplete 

X 10% medium/ low

PVL 3899 articulated skull and 
mandible

Left zygomatic arch and left 
postorbital bone absent, left 
coronoid process incomplete.

X 40% medium

PVL 3900 articulated skull and 
mandible 

Right zygomatic arch absent 
and both coronoid processes 
incomplete.

X X 45% medium

PVL 4072 mandible Both coronoid processes are 
incomplete. Shear deformed.

X X 5% medium/ low

Cynognathus crateronotus

PVL 3859 articulated skull and 
mandible

Right zygomatic arch 
incomplete. Shear deformed.

X X 5% low

Exaeretodon argentinus

MACN-PV 18125 skull Both nasal bones are absent. 
Dorsoventrally compressed.

X X 20% medium

MACN-PV 18125 mandible Right coronoid process is 
incomplete.
Una porción del extremo del 
proceso coronoides derecho 
ausente.

X 5% low

PVL 2056 skull Left zygomatic arch absent. 
Mediolaterally compressed.

X X 45% medium

PVL 2066 mandible Both coronoid processes are 
absent. Anterior part of the 
dentary is incomplete.

X X 45% medium

PVL 2473 articulated skull and 
mandible

Left side completely absent X 50% medium



FILIPPINI, ABDALA, & CASSINI: 3D SURFACE MODELS RESTORATION TECHNIQUES

6

Abbreviations: Extrp., extrapolation; % rest., percentage restored; Ref. & Sup., reflection of elements and superimposition; Rest.
Level, restoration level; Retrd., retrodeformation.

PVL 2564 skull Right zygomatic arch and right 
orbit absent, sagittal crest 
incomplete. Shear deformed.

X X X 55% high

PVL 2564 mandible Both coronoid processes are 
incomplete. Slightly shear 
deformed.

X X 20% medium/ low

Massetognathus pascuali

PVL 3901 skull Left zygomatic arch absent. 
Slightly shear deformed.

X X 10% medium

PVL 3901 mandible Shear deformed. X - low

PVL 3902 mandible Both coronoid processes are 
incomplete. Slightly shear 
deformed.

X X 10% medium/ low

PVL 3903 articulated skull and 
mandible 

Both coronoid processes are 
incomplete. Shear deformed.

X X 20% medium

PVL 4613 skull Right zygomatic arch and right 
postorbital bone absent.

X 45% medium

PVL 4613 mandible Both coronoid processes are 
incomplete.

X 25% medium

PVL 4726 mandible Shear deformed. X low

PVL 4727 skull Sagittal crest incomplete. X 25% medium

PVL 4728 articulated skull and 
mandible

Shear deformed. X - low

PVL 4729 skull Left postorbital bone absent. X 5% low

PVL 5441 skull Shear deformed. X - low

PVL 5445 mandible Right coronoid process is 
incomplete. 

X 10% low

PULR v02 skull Right zygomatic arch and right 
orbit absent.

X 40% medium

PULR v11 skull Dorsoventrally compressed. X - low

PULR v13 articulated skull and 
mandible

Shear deformed. X - low

Pascualgnathus polanskii

MLP 65-VI-18-1 skull Right zygomatic arch absent. X 35% medium

MLP 65-VI-18-1 mandible Both coronoid processes are 
incomplete.

X 5% low

PVL 3466 mandible Both coronoid processes are 
incomplete. 

X 5% low

PVL 4416 articulated skull and 
mandible

Heavily deformed. X X X 40% high

Specimen Cranial element Recorded damage

Restoration technique
% 

rest.
Rest. 
level

Ref. 
&Sup. Retrd. Extrp.

TABLE 1 (continued).
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element is isolated, a model of the edited dense
cloud is generated that can be exported to a 3D
model editing program, such as Blender. Two mod-
els are imported to Blender, the specimen to
restore and the edited fragment; and through the
option Object → Mirror (in the x, y, or z axis, or
manual) the isolated fragment is mirrored on the
side to repair. Then using the option transformation
manipulator → translating and rotating, both struc-
tures are manually aligned in the exact position.
Once the missing piece has been accommodated
in the original model, both models are merged with
the option Object → Join (Figure 1).
Superimposition. To carry out this type of restor-
ative process it is necessary to work with two spec-
imens. Specimen A would correspond to the
specimen to be restored, while specimen B is used
to extract the missing piece needed to restore
specimen A. First, specimen B is taken in the
Metashape program, and the area or piece neces-
sary to complete specimen A is selected and iso-
lated in the same way as described in the previous

procedure. Then, both models, the specimen A
and the isolated piece of specimen B, are imported
in the same project in Blender. In this program, the
restoration is continued by scaling the isolated
piece of specimen B to have the same size as
specimen A. This part of the process is done man-
ually with a transformation manipulator for scaling:
manual transformation → translation/rotation/scal-
ing. 

Transformation manipulators allow greater
control of the process, especially if the morpholo-
gies are not exactly the same. Once the correct
scaling and superimposition is achieved, both mod-
els are joined. (Object → Join). This technique was
performed in Massetognathus: on the mandibles of
specimens PVL 3902, PVL 3903, PVL 4613 with
PVL 3901 being used as specimen B, and on the
skull of PVL 3903 using PULR v10 as specimen B.
The skull PVL 2564 and the mandibles PVL 2066
of Exaeretodon, were restored utilizing as speci-
men B the skull and mandibles of MACN-PV
18125; and the snout of MACN-PV 12125 was

FIGURE 1. Reflection of elements. A. Selection of the section found complete in the skull of a Pascualgnathus
polanskii (MLP 65-VI-18-1) with Metashape. B. Generation of the model of the isolated section with Metashape and
mirroring in Blender. C. Alignment and fusion of both models in Blender to restore the skull.
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restored using PVL 2564 as specimen B. In Pas-
cualgnathus, the skull and mandibles of PVL 4416
(previously dismantled, see below) and mandibles
of PVL 3466 were restored utilizing as specimen B
the skull and mandible of MLP 65-VI-18-1 (Figure
2).

When no specimen of the same species is
available, a specimen of another closely related
species may be used for restoration and missing
parts are superimposed. This procedure assumes
that there is no morphological variability between
the taxonomic units selected and therefore implies
a certain degree of interpretation. This method was
only applied to the dentaries of Andescynodon
specimens (PVL 3092, PVL 3835, PVL 3891, PVL
3894, PVL 3898, PVL 3900, PVL 4072), which
none of them had a complete coronoid process. In
this case, to restore the missing parts of the mandi-
ble we superimposed sections of the dentary bone
from the closely related Pascualgnathus, using
MLP 65-VI-18-1
Retrodeformation. As mentioned above, retrode-
formation methods use the principle of bilateral
symmetry, assuming that one symmetric counter-
part has undergone deformation with respect to the
other. A common method uses paired landmarks
placed on both sides of the sagittal plane. Based
on this set of landmarks, the object is then
deformed so that each landmark occupies the
same plane as its counterpart, which are orthogo-
nal with respect to the sagittal plane of symmetry.
This was done using the Landmark software. Once
the set of paired landmarks are arranged, go to the
Project → Retrodeform Pairs → Single axis and
the software performs the retrodeformation auto-
matically (Figure 3). The resulting model is then
exported as a PLY file. This method was useful for
shear deformed fossils, like in Andescynodon PVL
3835, PVL 3894, PVL 3898, and PVL 4072; Exaer-
etodon PVL 2468; Massetognathus PVL 3901 and
PVL 4726; and Pascualgnathus PVL 4416. Never-
theless, this procedure was not very effective in
cases where the specimens were crushed or com-
pressed, as in specimens PVL 3092 of Andescyno-
don, PVL 2056 and MACN-PV 18125 of
Exaeretodon, PULR v11 and PULR v13 of Masse-
tognathus (PULR v13 is shear deformed but the
landmark editor could not correct completely). In
cases where the deformation is strongly directional
(PVL 3092, PVL 2056, PULR v11) or one part of
the fossil is deformed (the snout of MACN-PV
18125), manual retrodeformation can be per-
formed. However, because of its high level of sub-
jectivity, it is necessary to proceed with caution and

in a gradual manner so as to avoid distorting the
anatomy of the specimen. Manual retrodeformation
was realized using Blender’s manual transformers.
It was not possible to completely retrodeform spec-
imens highly compressed as in Andescynodon
PVL 3092, PVL 3891, Exaeretodon PVL 2056 y
PVL 2066.

FIGURE 2. Superimposition. A. Mandible of Massetog-
nathus pascuali PVL 4613, specimen A to be restored.
B. Mandibles of Massetognathus pascuali PVL 3901
used as specimen B. C. Isolated coronoid process of
specimen B. D. Restored mandibles of Massetognathus
pascuali PVL 4613.
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Dismantling of elements. Pascualgnathus PVL
4416, consists of an articulated skull and mandible
with a high degree of shear deformation. This type
of damage caused the mandible to be misaligned
with respect to the cranial sagittal plane, displacing
the anterior part of the dentary mostly on the right
side of the snout (Figure 4A). Initially we tried to
use the retrodeformation method following the
steps explained above. However, the resulting
model did not recover the symmetry completely of
the specimen and distorted the anatomy. There-
fore, we had to recur to another way of recovering
the original shape of the specimen without modify-
ing its anatomy.

Since the skull and the mandible appeared to
present different degrees of deformation, the sim-
plest solution was to separate both elements and
then restore them separately. This was achieved
by editing the dense point cloud in Metashape,
resulting in two separate models for the skull and
the mandible. Subsequently, the retrodeformation
and restoration was performed independently in
skull and mandible as it was done with other speci-
mens. The retrodeformation was realized with the
Landmark editor as explained above. Fragmented
sections of the skull and the coronoid processes of
the mandible of PVL 4416 were restored using
superimposition and MLP 65-VI-18-1 as specimen
B. This procedure was created to solve this specific
complex case.

Percentage and Grade of Restoration 

The majority of the specimens, 56% of the
sample, present a medium level of restoration, fol-
lowed by 36.5% requiring low level of restoration
and 7.3% (three specimens) that required high
level of restoration. 

The Cynognathus skull and mandible are
nearly complete and required about 5% of resto-
ration (i.e., low level). Of 11 Andescynodon speci-
mens that underwent restoration, eight were
restored by superimposition using a specimen from
the close related species (Pascualgnathus), being
the species in which this method was more often
used. One of the three specimens of Pascual-
gnathus, PVL 4416 showed the highest-degree of
deformation in the sample, especially crushing and
shearing of the skull and mandible, which led to a
longer restoration process (Figure 4). The other
two Pascualgnathus specimens were restored
using one technique, reflection of elements or
superimposition (i.e., medium to low level). The
specimens of Massetognathus presented a low
degree of damage and deformation in general
(53.3% low level, 46.6% medium level restoration).
In general, these restorations were easily resolved,
with 80% of the specimens needing to undergo
only one of the techniques to be restored. The
method most commonly used was retrodeforma-
tion applied in 60 % of the specimens, while the
superimposition was less used (26.6%). For Exaer-

FIGURE 3. Retrodeformation. A. Mandible in anterior view of Massetognathus pascuali (PVL 4726) shear deformed.
B. Retrodeformed model of the mandible in the Landmark program.
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etodon, the most used techniques were reflection
and superimposition of elements to resolve the
most severe damage (i.e., medium level resto-
ration), which was applied in all the specimens.
Additionally, manual retrodeformation was applied
in 57% of the samples. 

In general, the deformation produced by com-
pression in the cynognathian specimens was cor-
rected manually. However, in the most extreme
cases as observed in PVL 3092, PVL 3891, PVL
2056 y PVL 2066 it was not possible to perform a
total retrodeformation (Figure 5, A and B), being
the 12.5% of the total sample that could not be fully

restored. In addition, specimens were left out from
the restoration process due to the impossibility of
applying any of the techniques, which are not listed
in this work and had to be left out entirely of the
posterior analysis made. The left out specimens
are two from Andescynodon species, the skull of
PVL 3892 and mandibles of PVL 3890, and one
Exaeretodon specimen, the skull of PVL 2554.
These specimens present such a degree of dam-
age that it is not possible to avoid a high degree of
uncertainty at the moment of attempting to restore
them. In the case of the skulls PVL 3892 and PVL
2554, have large missing areas which makes

FIGURE 4. Dismantling of elements for restoration separately. A. Pascualgnathus polanskii (PVL 4416) with a high
deformation grade. B. Disarticulated and independently modeled skull and mandible. C. Skull and mandible restored
using the steps explained in the text (mirroring of elements).
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certain important anatomical features such as the
postcanine dental rows or the height of the skull
very uncertain (Figure 5C). While the mandibles of
PVL 3890 present an incomplete preparation hav-
ing a block of sediment within the hemimandibles
(Figure 5D). 

In summary, the total sample consisted of 32
specimens, 62.5%, (20) of the specimens were
deformed and 90.6% (29) were fragmented and
represented missing areas. All the specimens that
have missing areas were restored completely. Of
the specimens that were affected by deformation,
80% were successfully retrodeformed and only
20% were not able to remove the deformation com-
pletely. Additionally, three specimens were com-
pletely left out of the restorative process due to the
level of damage presented.

DISCUSSION

Among the damages observed in our sample,
partial fragmentation or total loss of one of the
zygomatic arches, total loss of the postdentary
bones and deformation due to lithostatic load stand
out. The cranial elements of cynognathians are
mostly dorsoventrally compressed, and to a lesser
extent, mediolaterally compressed or sheared.

Massetognathus shows the best grade of
preservation of its specimens, with little deforma-
tion and fragmentation regardless of the specimen
size. The only specimen of Cynognathus is very
well preserved, probably for their characteristic
anteroposteriorly short zygomatic areas, broad
occipital plate, and low coronoid process, which
gives a greater robustness to the skull and jaws
compared to other cynognathians. Thus, a more
robust construction of the skull allows a greater
resistance against fragmentation. Andescynodon
small specimens commonly show deformation and
fragmentation. Only Pascualgnathus PVL 4416
shows the highest degree of multidirectional defor-
mation, which does not occur in other specimens.
The large Exaeretodon specimens show as distinc-
tion the fragmentation in the parietal and occipital
crests that could be a size effect. In general, the
most fragile part in cynognathians skull are zygo-
matic arches, due to both brittle and plastic defor-
mation. This is the area most affected by
compressive forces, often leaving the zygomatic
arches closer to the cranial walls.

As for the mandible, most of the damaged
areas correspond to the detachment (an absence)
of the postdentary bones and the broken tips at dif-
ferent levels of the coronoid processes. The post-

FIGURE 5. Cynognathian specimens which could not be fully restored (A, B) and specimens that were left out from
the restoration process due to the level of damage could not be resolved with any of the restoration techniques
described (C, D). A. Dorsal view of skull and mandibles of Andescynodon mendozensis PVL 3092 showing a slightly
mediolaterally compress. B. Dorsal view of the skull of Exaeretodon PVL 2056b showing pronounced mediolaterally
compression. C. Ventral view of skull of Andescynodon mendozensis PVL 3892 in which it can be appreciated the
missing anterior part of the snout. D. Dorsal view of incompletely prepared mandibles of Andescynodon mendozensis
PVL 3890.
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dentary bones are small and loosely attached to
the dentary, and they are frequently lost in fossils of
non-mammaliaform cynodonts before fossilization.
The loss of these bones occurs in all species to an
equal extent, regardless of size. In Andescynodon
specimen’s large areas or coronoid processes are
usually missing. Sometimes the complete pro-
cesses are missing, preserving only the alveolar
ramus. As for deformation, it is common for the
dentaries to present shear deformation.

The grade of damage and deformation
recorded in cynognathian fossils is variable also
depending on the different deposits in which they
were found. Most specimens come from siltstone
or sandstone deposits intercalated with sediments
of pyroclastic origin such as tuffs deposits (Abdala,
1996; Bonaparte, 1962, 1966a, 1966b, 1969, 1997;
Martinelli and de la Fuente, 2008; Martinelli et al.,
2009; Martínez et al., 2012; Mancuso et al., 2021).
Specimens of Pascualgnathus extracted from the
Rio Seco de la Quebrada Formation show different
states of deformation, or in Andescynodon from the
Cerro de las Cabras Formation the specimens
have the same degree of deformation, but different
fragmentation, Exaeretodon from the Ischigualasto
Formation features different degree of fragmenta-
tion and deformation. Most of the fossils of the
Chañares Formation were found in facies rich in
calcareous concretions (Romer et al., 1966; Bona-
parte, 1997; Rogers et al., 2001; Fiorelli et al.,
2013; Mancuso et al., 2014, 2021), mostly within
them, so they were protected and therefore less
affected by diagenetic processes. This could
explain why Massetognathus skulls and mandibles
had the best preservation in the whole sample,
regardless of their size. Cynognathus and Masse-
tognathus specimens required a low level of resto-
ration, while the remaining cynodonts specimens
required a medium to high level of restoration.

Most of the damages and deformations were
solved by means of one of the three chosen tech-
niques or a combination of them (reflection and/or
superimposition of elements, and retrodeforma-
tion). In Massetognathus, Pascualgnathus, and
Cynognathus reflection of elements and retrodefor-
mation were the most used techniques, whereas in
Andescynodon and Exaeretodon superimposition
and retrodeformation were the most used. Other
kinds of damages such as, unidirectional deforma-
tion in dorsoventral and mediolateral compressions
of greater magnitude, were the only restorative
problem that could not be solved. This is due to the
fact that the landmark software uses bilateral sym-
metry to calculate the degree and direction of com-

pression to perform retrodeformation, which is
useful when the symmetrical deformation occurs
differentially on each side of the specimen.
Although manual retrodeformation could be used
instead, it requires a higher level of speculation
about the original morphology of the fossil. There-
fore, we avoided its overuse.

Digital restoration techniques are a very use-
ful tool to remove damage from fossil specimens
(Lautenschlager, 2016), and help to increase the
sample in studies of morphological variation and
paleobiological analysis. Usually, studies that
requires linear measurements or landmark data for
morphometric analyses select specimens with little
to no apparent deformation or with completeness
of parts of interest (Foth et al., 2012; Cassini, 2013;
Ordonez et al., 2019; Ercoli et al., 2021; Knapp et
al., 2021), so it is necessary to correct morphologi-
cal distortion as much as possible (Herbst et al.,
2022). This is the case with the restored cynog-
nathians specimens, which were subsequently
subjected to morpho-functional analysis (Filippini,
2023). Considering that in the sample predominate
medium (56%) and low (36.5%) restoration level
we consider the results in these cases to be reli-
able (i.e., the restorations would not introduce sig-
nificant biases in morpho-functional analyses). At
the same time, this process allowed us to eliminate
the errors that could introduce the deformation of
most of the specimens and to incorporate ten spec-
imens of Andescynodon, six of Exaeretodon, five
of Massetognathus, two of Pascualgnathus, and
one Cynognathus to the total sample of cynodonts
that were part of the subsequent morpho-functional
analysis (see Filippini et al., 2022). 

Several studies used similar digital restoration
techniques in 3D models to those described in the
present work. Mirroring and superimposition tech-
niques to complete the missing part of the fossil
specimen, either with the same specimen or using
another specimen as reference (Zollikofer et al.,
2005; Gunz et al., 2009; Grine et al., 2010; Attard
et al., 2014), performing restoration using manual
manipulators of the programs (Lautenschlager,
2013; Cuff and Rayfield, 2015; Porro et al., 2015)
and retrodeformation using landmarks (Ogihara et
al., 2006; Molnar et al., 2012; Tallman et al., 2014).
These works are commonly focused on performing
a restoration in a single or multiple elements of one
single specimen or a couple of specimens. Hence,
studies involving large numbers of restored speci-
mens from different species with different degrees
of damage are not commonly found in the litera-
ture, being this work, in our knowledge, one of the
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first recorded. In our particular case, the goal was
to organize and adapt a restoration protocol that
could be applied sequentially throughout the entire
fossil sample which contained numerous speci-
mens. And more importantly, to remove as much
damage and deformation from the fossils as possi-
ble, in order to increase the sample per species in
a posterior morpho-functional analysis.

Detailed description of the type of damage in
the fossil sample is important to identify the most
common damage present in each taxon, and
accordingly establish a procedure to be applied
consistently throughout the sample. In addition, it is
advisable to identify the best-preserved specimens
of the sample of the same taxon to use them as
reference models to complete other specimens or
as a comparative model to use as an anatomical
guide. All types of reference are also recom-
mended to minimize user bias, e.g., photographs,
drawings, descriptions, and any other source of
anatomical information from fossils or extant taxa
(Lautenschlager, 2016a; Herbst et al., 2022).
Recording the levels of restoration can provide
practical information for other researches of the
type of 3D model being dealt with. The restoration
process does not always recover the original anat-
omy completely (Angielczyk and Sheets, 2007;
Tschopp et al., 2013; Schlager et al., 2018), mod-
els with high restoration levels or unsolved
deformed specimens may influence the results of
geometric morphometric analysis of shape (Foth
and Rauhut, 2013; Kammerer et al., 2020). The
recording of restoration levels would allow easy
identification of specimens that could cause subse-
quent problems in analyses, especially when deal-
ing with large samples. As these specimens have
the highest level of uncertainty it is necessary to
pay special attention to the effect they may have in
shape variation analyses. Distorted specimens can
be misplaced in morphospace respect other speci-
mens of the same species, however when included
to calculate mean morphologies in multispecies
analysis the error of disparity is minimal (Kam-
merer et al., 2020).

Digital tools have advanced in recent years
and have been applied to different groups of fossil
vertebrates (Lautenschlager 2016a, b), and studies
describing new detailed restoration methodologies
on 3D models are more frequent in paleontology
(Lautenschlager, 2016b; Demuth et al., 2022;
Herbst et al., 2022; Rowe and Rayfield, 2022;
Ruella et al., 2024). As previous works had estab-
lished, it is recommended that a detailed descrip-
tion of the entire restoration process is made in

order to inform with clarity the decision-making pro-
cess. We proposed a detailed description and cate-
gorization of the percentage of the damage that the
specimen presents, which allows establishing a
concise and clear protocol to minimize user bias,
additionally permitting traceability of the modifica-
tions made to the model with the level of resto-
ration classification. This work will be very useful
for other researchers, for ensuring transparency at
the moment to inform about the process, in addi-
tion to providing a guide tool for the techniques and
procedures for restoration of surface 3D models
and set as an example of case study for digital res-
toration with large samples.

CONCLUSIONS

In the last few years, works describing the
development of techniques and protocols to be fol-
lowed for the restoration of 3D models in vertebrate
paleontology have started to become more fre-
quent. We present a guide to performing resto-
rations specifically on surface models of cranial
elements, as one of the few examples of resto-
rations with a large sample of specimens from the
same group. At the same time, we present a scale
of restoration levels that allows us to give an esti-
mate of the level of uncertainty that is added to the
sample and to recognize which taxa could intro-
duce biases in subsequent analyses.

The main damages registered in the cynog-
nathian specimens are fragmentation of the zygo-
matic arches, the coronoid processes, and loss of
postdentary bones, in addition to lithostatic defor-
mation, predominantly compression. For the resto-
ration process, three techniques previously
described by other authors and adapted to 3D sur-
face models were used: reflections of elements,
superimposition, and retrodeformation. Addition-
ally, a particular technique was created for the case
of the specimen of Pascualgnathus PVL 4416, the
disarticulation of elements. For Cynognathus,
Andescynodon, and Massetognathus specimens
the most used technique was the reflection of ele-
ments, while for Andescynodon and Exaeretodon,
the superimposition was most used. Retrodeforma-
tion was used equally for all species in general,
either using landmarks or manual transformers in
Blender.

The majority of the cynognathians specimens
present a medium and low restoration level (56%
and 36.5% of the sample, respectively), being the
specimens with high restoration level a low per-
centage (7.3%). Of the total number of specimens
showing deformation (90.6%), only 20% could not
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be fully retrodeformed due to a strong unidirec-
tional deformation. Despite the tools available,
there were three specimens that could not be prop-
erly restored due to a high degree of damage and
have been eliminated from the sample for future
analysis.

This work contributes to the record of resto-
ration processes and computational tool sets avail-
able to other researchers facing similar problems
with fossil vertebrates. In addition to proposing a
simple way to inform about the type of processes
and ensure traceability of the restorative pro-
cesses.
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